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Introduction 

This document has been written entirely with Geneva characters from 
12 to 24 point, so if it looks "strange" on your display make sure you have 
this font installed. 

I have been asked to write a set of macros for Excel 3.0 to accomplish 
these tasks: 

• Help a person who wants to design a set of tiles for a calorimeter to 
setup the spreadsheet for the coordinate points to be fed into the 
Thermwood cutting machine with a user-friendly interface; 

• Help that person to perform a what-if analysis with on screen 
drawings of the designed mechanical pieces. 

Although the Thermwood is a numerically controlled cutting machine no 
software was available to generate the G code other than doing it by hand. 
Before I started working on this project, Mike Banas had designed a 
spreadsheet which needs only the data of the first tile and then projects· 
the information to obtain the complete set of coordinates for each tile in 
a tower where the tiles retain the same shape but grow larger towards 
the back. This spreadsheet would then be brought to LAB 8, where the 
Thermwood is. Jon Blomquist designed some macros that can read these 
Excel spreadsheets and convert their contents into the G codes for the 
machine. This system represented a huge improvement in efficiency over 
previous hand coding methods. 

The main problems in this chain, however, were that a person could not 
easily feed his/her data in the spreadsheet without knowing Excel 3.0 and 
the structure of the spreadsheet itself, and that to have a drawing of the 
tiles before cutting them one had to replace the Thermwood's cutting tool 
with an ink pen, thus transforming the Thermwood machine into a plotter. 

Realizing that this still wasn't the most efficient way to work, an idea 
came to someone, somewhere in Wilson Hall: why not hire a summer 
student to get this thing a little bit better ? 

It was my fate to be that summer student and this document is the 
result of what I have been doing for the past 6 weeks. 
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General description 

--TILDE-- is the name I have given to this set of macros that run under 
Excel 3.0 for the Macintosh, the name stands for Tiles Designer. The 
macr~s form a very simple CAD/CAM tool that follows the standard 
Macintosh interface (dialog boxes, menus, ... ) to be as user friendly as I 
could make. However there are certain operations that require the user to 
slightly modify the spreadsheet to fit his/her needs; these are described 
later on more specifically. 

The hardware requirements to run this program are the usual ones for 
Excel 3.0 (any Macintosh with at least 2 Mbytes of RAM). However anyone 
would quickly thank himself/herself for using a fast Macintosh and a big 
screen because of the sluggishness of Excel macro language and the size 
of the spreadsheets. 

To run --TILDE-- you need the following files to be in the same folder: 

• --TILDE--

• Tiles_mcr 

• Tiles 

• Drawing 

The file " ...... TILDE-- " is the start-up file. It contains the title of the 
program and the auto-executing macro that loads the file Tiles_mcr, 
which contains the macros. 
The files "Tiles" and "Drawing", are the templates for the worksheet and 
the spreadsheet where the drawings of the tiles are shown. All of these­
files need to be in the same folder because they are called from the 
program and if it doesn't find them it will give an error message, 
interrupting the execution of the macro. 

The rest of this document is a user manual for TILDE. I will assume 
that the reader is familiar with the basic Macintosh operations, such as 
use of menus and dialog boxes, double-clicking, etc. if he/she is not 
he/she should first develop familiarity with the Macintosh and then come 
back to this document. 
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This document is divided into: 

• a tutorial that leads the user step by step through the basic 
features of TILDE building a worksheet and drawing a few tiles from 
it; 

• a reference manual which explains all of the structures of the 
user interface {menus, dialog boxes, ... ). A hardcopy of the macros 
output is also included; 

• a programmer's guide, which is an accurate description of the 
macros for any future upgrade or modification. It includes a detailed 
flow-chart and a printout of the Excel code. 

All of the macros in Tiles_mcr except the core of "Drawing" have been 
written by: 

Luca Marinelli 
Summer Student in Fermilab Physics Dept. 

University of Genova 
Italy. 

The core of the macro Drawing and the macros to extract the 
information for the Thermwood machine out of the spreadsheets have been 
written by: 

Jon R. Blomquist 
Physics Dept. 

Mechanical Group 
Fermilab. 

The spreadsheets have been designed and realized by: 

Mike J. Banas 
S.D.C. Dept. 

Mechanical Support 
Fermilab. 
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Tutorial 

1. Double click the MS Excel 3.0 icon to start the application (Version 
3.0 is mandatory !). 

2. Open the document --TILDE-- using Open ... under the File menu. 
Do not use the lower part of the File menu to open this 
document even if you see --TILDE-- there, otherwise the 
macros won't work. 

You should see the menu bar forming and the window "Tiles 1" should be 
opened in less than a minute. Now you can start building up a worksheet. 
Let's suppose you wanted to design a set of rectangular tiles for an 
electromagnetic calorimeter with a notch and a groove. 

First you would have to setup the groove, let's suppose you wanted a 
groove whose distance to the top, left and right side of the tile is the 
same and its value switches among 375, 500, 625 thousandths of an inch, 
while the distance from the bottom is increased as the notch depth (by 
convention the notch is at the bottom): 

3. Select the cell 026 (Groove to Top edge) and write in the formula 
bar = 1 2 5 * ( M 0 D ( D 2 0 + 2, 3) + 3) . 

4. Select the cell 034 (Groove to side edge) and write in the formula 
bar :D26. 

5.. Now let's insert the data for the tiles. Open the menu Data, select 
Insert· Data... and type the data as in the figures in the next three 

pages. 

After you pressed RETURN you should see the worksheet being filled 
with numbers and in a minute or so you have your worksheet completed. 
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Tiles Layout 

Number of tiles 148 

H of first tile 14877.4 H step 112.152 

Y of first tile 14877.4 Y step I 12.1 s2 

RLL URLUES MUST BE ENTERED IN MI LS. 

( Notch ) (Groove ) 

(( OK D ( Cancel ) 
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Grooue 

Edge to grooue: Top 1375 I 
Side 1375 I 

Bottom j 125 I 

Bend Radius I 100~ I 

K OK )J ( Cancel ) 
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Notcfl Description 

N~tc~ s~;n for fronf tao,fl ...._-_lo_. ___, 

N~mper ~f tU~s of J~e ~ncrer11e~H l.__2_1 _ __. 

K OK » 

pep~~ l...._~_75 _ __. 

P:epl~ 'ncremen' 12.45 

(Cancel ) 



You can now save your work using the Save as ••• command under the 
File menu, this file is the one that has to b~ given to the LAB 8 people for 
the actual cutting of the tiles with the Thermwood. 

Now you are ready to go on looking at what you have designed using the 
drawing facilities. First of all have a look at the various parts of the 
worksheet. 

6. Use the Goto Tile ... command under the Data menu to browse 
through the worksheet: choose which tile you want to see and 
which section. 

It's very important that you always activate the spreadsheet from 
which you want to take the data to build a drawing before calling the 
drawing routine otherwise you will produce meaningless drawings without 
receiving any warning from the macro because you didn't do any kind of 
mistake. 

7. Let's draw one of the tiles, for example tile number 10. Choose 
Draw Tile ... under the Draw menu and insert "1 O" at the prompt. 
In a couple of minutes you should see the drawing with the 
dimensions and the letters completed. Isn't that easy ? 

8. Print a copy of the drawing on your printer by clicking on the Print 
Drawing button and do the same for the data, if you also wish to 
keep the coordinates of the corner points of the drawing. 

x 

Remember that the point A has always coordinates (0,0) and that 
the y axis is across the page, while the x axis is down the page. 

A 

v 
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V of first tile 
Groove to ~ 
side edge j-f- l~ove to top edge 

rA---------------------------------8~ 
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? 

Bend radius 
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L Q Notch depth 1 Groove to 
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littom edge 

H c 
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ff 

Notch shift 

What is what in the tile 
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9. Now save your drawing giving it a name with the Save as ... 
command just as with the worksheet. 

Using --TILDE-- you can also overlay as many tiles as you want using 
the Overlap Tiles... command. This routine draws only the shape of the 
tile, without adding the dimensions, for example, to make the drawing 
clearer. Nonetheless I suggest you overlapped just two ""' ~hree tiles at a 
time otherwise the drawing would become unreadable. 

Let's suppose you wanted to overlap tiles number 3 and number 46. You 
should write the biggest tile first as will be explained on page 14. 

1 O. Select Overlap Tiles .•. under the Draw menu type 46 in the first 
dialog box, and wait until tile number 46 has been drawn. 

11 . Now type 3 in the second dialog box and in another minute or so 
also tile 3 has been drawn. 

12. Now you can click the Cancel button in the dialog box when it 
appears for the third time and you are done. 

13. You can print the final drawing or save it if you wish using the 
same procedures as in 8. and 9. 

The program is very slow, especially if you are using an older Mac. but 
on a Mac II for example you can turn color off and in this way you will gain 
in speed without losing clarity because colors are not used in ...... TILDE;..­
(1 wrote it on a Macintosh SE). 

You can now give --TILDE-- a try by yourself opening a new worksheet 
with the New Worksheet command under the File menu or modifying the 
one you have just created. If you feel comfortable enough with it you may 
even want to start reading the Reference Manual right away to see what 
exactly each menu command does. 
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Reference Manual 

The File menu 

New Worksheet: This command creates a new worksheet to operate 
on. This does not create a new drawing window, if you need that you can do 
Open ... and double-click the file Drawing. 

Open ... : This menu item is used to open saved worksheets or drawings 
but can be used to open any Excel document. A more exhaustive description 
can be found in the MS Excel 3.0 User's guide on page 67. 

Close. Save. Saye As ... : They are the used as the standard Macintosh 
commands. The dialog box which appears in the Save As •.. Command is 
described in the MS Excel 3.0 User's gujde on page 129. 

Return to Excel: This command quits --TILDE-- and goes back to the 
MS Excel 3.0 shell building the Full Menus menu bar . 

.Qytt: Quits --TILDE-- and MS Excel returning the control to the Finder. 

The Edit menu 

Undo: This command undoes the last executed operation, if possible. 

Cut. Copy. Paste: These are the standard editing commands used in 
any Macintosh application. 

Show Clipboard: Another standard Macintosh command: it opens a 
window showing the content of the Clipboard. 
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The Data menu 

Insert Data ... : This menu item is the key command to build a 
worksheet. It shows a dialog box where you can insert the data concerning 
the structure of the tiles (Number of tiles, X of first tile, Y of first 
tile) and asks for the parameters of the projection (X step and Y step). 
From this dialog box you can access two other dialog boxes: the Groove 
and the the Notch Description. You don't have to open these two dialog 
boxes but if you do, a flag will be set telling the other macros that your 
tiles have a notch or a groove. 

The change in the groove from tile to tile, must be set in the 
worksheet, as has been shown in the tutorial, while the initial values have 
to be set in the dialog box. The cells that have to be modified are 026 
(Groove to top edge), 033 {Groove to bottom edge) and 034 {Groove 
to side edge). If you cannot find an analytic relation between the tile 
number and "Groove to edge" distance, you can build the worksheet and 
then modify the three rows (26, 33, 34) by hand, inserting the values for 
each tile. In addition to the distances from the tile edges, you also need a 
bend radius, which is the same for the 4 corners, and which can be set in 
the Groove dialog box. The notch is completely described by a shift from 
the left side of the tile (Notch shift), a width (Notch width) and a 
depth inside the tile (Notch depth). The Notch shift increment can be set 
to two different values so that you can move it back and forth (Notch 
shift for front half, Notch shift for back half, Number of tiles of 
the increment). 

After the data have been inserted, this macro will perform the 
calculations to build the worksheet and, if you have a notch and a groove, 
it will also make simple checks to see if the notch crosses the groove 
radius and in that case it will show an alert dialog warning the user. 
Remember that all the data must be entered in thousandths of an inch. 
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Calculate Now: This is used to propagate changes throughout the 

document because I have switched off automatic calculation to improve 
the speed of the program a little bit. So if you make any change to the 
worksheet and you want to see how this affects the whole worksheet you 
have to select Calculate Now. For more information see the MS Excel 3.0 
User's Guide on page 287. 

Goto Tile ... : This command is used to move quickly from one part of 
the worksheet to another. When invoked, it shows a dialog box prompting 
the user for the tile number he wants to go to and the area he/she wants 
to see. This can be chosen with a radio button group. This command is 
especially useful with very large worksheets because in that case the 
scrolling bars operate very slowly. 
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The Draw menu 

Draw Tife ... : This is the central menu item for the drawing utilities. 
It enables the user to choose which tile is to be drawn, via a simple dialog 
box. It is important that you do not enter the Groove and Notch 
Description dialog boxes if you don't have one because otherwise the 
drawing will be messed up, due to the fact that the dimensioning, for 
example, is done differently, depending whether you have a notch, or a 
groove, or both, or whatever. However if you do call the Groove or the 
Notch Description dialog box you can still press the Cancel button or, 
if it is too late to do that you can start again by choosing Insert Data ... 
from the Data menu. After you have drawn a tile you can make a hard-copy 
of it by pressing the Print Drawing button on the Drawing window, you 
can also print the data used to generate that drawing by pressing the 
Print Data button on the Drawing window. 

Overtap Tiles ... : This command is used to draw simultaneously more 
than one tile in the Drawing window. It asks the user to write the number 
of the biggest tile he wants to be drawn; it is important that you give 
--TILDE-- the tiles in the correct order (the first one must be the 
biggest, then the other tiles can be given in any order) as the program uses 
the data of the first tile to compute the scale factor to fit the tiles in the 
cell. After the first tile has been drawn, the macro will continue 
prompting the user for a new tile number to draw; when you are finished 
you just have to press the Cancel button. Unfortunately, I couldn't make 
the data of every tile be displayed one after the other so you will find only 
the data relative to the last tile on the Drawing window. That should be 
fixed by a following version. 
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The Window menu 

Activate next: This command is used when you are working with 
multiple windows documents to show the window underneath the active 
one. For more information you can see the MS Excel User's Guide on page 
25. 

Activate next worksheet. Activate next drawing: These two 
commands are used to activate the next worksheet or the next drawing 
underneath the active window. The two kind of windows are recognized 
looking at the height of row 1: if it exceeds 200 points then it is thought 
to be a drawing window, so be careful if you change the height of the 
first row. 

IMPORTANT: These three commands should be used rather than 

clicking in a window to activate it because they skip automatically the 
macro sheet Tiles_mcr, preventing the user to do any possible damage to 
it. However if you do select windows clicking in them be careful not to 
start any operation while the macro sheet is the active window otherwise 
you will result in a macro stop and you will damage it. Even if this occurs, 
the macro sheet won't save himself when leaving --TILDE-- so it 
shouldn't undergo any modification unless you saved it prior to quitting 
the application. 
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4.9/38" 
! 

A B 

H c 

This is the simplest kind of tile you can design. 
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r-----4.938"---i 
A B 

F E 
H 

" a:> ..... 
0 

,r-------.. c 
----------------- ~...----

~ 1. 788 "~ -

This tile has got a notch but not a groove 

Note that the dimensions are drawn according to the intricacy of the tile 
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0.625"~ 4.938" 
t-0.625" ~ 1.688" ___., 

___.,, 
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A 8 

r N 0 
Ul 
C\I 
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0 

r M v+ p 

co 
C') 

co en 
co v-· ...-·-
C\I 

1 L a 
lO 
C\I ,.... 
0 

K R ~~ H c 

This tile has got a groove but not a notch. 
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_t_~ 4.962" 1-0.5" 0.5" ~ ~ 1.962"~ ~ 
A B 

F N 0 

Ln 
0 

T 
M ~ p v 

+ N 

N '° a-to -i' N 

l N 
a-

L Q 
0 

N ....,. 

0 

K F R M H c 

~2.883"~ ~· ~ 1.579" 

This is the most complicate tile you can draw with .......... TILDE--. 

It has both a notch and a groove. 
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Keyboard Shortcuts~ 

File 

New Worksheet 

Open ••• 

Close 

Save 

Save As ••• 

Return to Excel 

Quit 

Edit 

Undo 

Cut 

Copy 

Paste 

Data 

Insert Data ••• 

Calculate now 

Goto tile ••• 

Draw 

Draw Tile ••• 

Overlap Tiles ••. 

Window 

Activate next 
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Option-Cmd. n 

Option-Cmd. o 

Option-Cmd. e 

Option-Cmd. s 

Option-Cmd. h 

Option-Cmd. r 

Option-Cmd. q 

Option-Cmd. z 

Option-Cmd. x 

Option-Cmd. c 

Option-Cmd. v 

Option-Cmd. i 

Option-Cmd. I 

Option-Cmd. g 

Option-Cmd. d 

Option-Cmd. p 

Option-Cmd. a 



Tiles template 

A B c D E F G H I J K L M 
1 ®@©~~ 

2 

3 THE FOLLOWING PROGRAM COMPlfTES THE COORDINAlES OF THE 
4 SCINTILLATING TILES FOR THE MP BEAMTEST CALORIMETER 
5 FOR MANUFACTURE ON THE THERMWOOD CNC MACHINE AT LAB 8. 
6 
7 THE TOP LEFT CORNER OF THE TILE IS ( 0, 0 ). 
8 THE •x• DIRECTION IS DOWN THE PAGE 
9 THE "Y" DIRECTION IS ACROSS THE PAGE. 

1 0 
11 
1 2 
1 3 ALL VALUES MUST BE ENTERED IN MILS. 
1 4 
1 5 XSTAAT= 0 XSTEP= 0 NOTCHDEFTH 
1 6 YSTART= 0 YSTEP= 0 INCREMENT .. 0 
1 7 
1 8 TOTAL NUMBER OF TILES • 2 
1 9 
20 TILE 1 2 
21 I 
22 x- 0 0 
23 y. 0 0 
24 NOTCH WIDTH • 0 0 
25 BEND RADIUS • 0 0 
26 EDGE-GAVE 10P .. 0 0 
27 NOTCH DEPTH • 0 0 
28 MIN NOTCHSHIFT 0 0 
29 MAX NOTCHSHIFT 0 0 
30 NOTCH SHIFT= 0 0 
31 CHECK1 0 0 
32 CHECK2 0 0 
33 EDGE-GAVE BOT· 0 0 
34 EDGE-GAVE SIDE- 0 0 
35 NOTCH SHIFT FOR FRONT HALF 0 O£CK 
36 MINIMUM NOTCH SHIFT OF FIRST TILE 0 
37 MAXIMUM NOTCH SHIFT OF MIDDLE TILE 0 APPLICABILITY 
38 NUMBER OF TILES OF THE INCREMENT 2 
39 ACTUAL NOTCH SHIFT OF MIDDLE TILE 0 FtR ' 

40 MINIMUM NOTCH SHIFT OF LAST TILE 0 
41 NUMBER OF TILES OF THE INCREMENT 0 THIS 
42 NOTCH SHIFT FOR BACK HALF 0 

43 SECTION 
44 IF A NEGATIVE NUMBER APPEARS IN THE CHECK, 
45 THEN THE GEOMETRY IS UNACCEPTABLE 
46 SINCE THE NOTCH CROSSES IN10 THE GROOVE RADIUS. 
47 
48 COORDINATE POINTS 
49 TILE 1 2 
50 AX 0 0 
51 AY 0 0 
52 BX 0 0 
53 BV 0 0 

54 0( 0 0 
55 Of 0 0 

56 [)( 0 0 
57 IJ( 0 0 

58 EX 0 0 

59 CY 0 0 

60 FX 0 0 
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Tiles template 

A B c D E F G H I J K L M 
61 p( 0 0 
62 GC 0 0 
63 G( 0 0 
64 HC 0 0 
65 Hf 0 0 
66 IX 0 0 
67 IY 0 0 
68 IQ( 0 0 
61i1 KY 0 0 
70 l.X 0 0 
71 LY 0 0 
72 MC 0 0 
73 Mf 0 0 
74 NC 0 0 
75 Nf 0 0 
76 ex 0 0 
77 Of 0 0 
78 PX 0 0 
79 Pf 0 0 
80 ex 0 0 
81 Q( 0 0 
82 F« 0 0 
83 Rf 0 0 
84 TIC 0 0 
85 TY 0 0 
86 lJ( 0 0 
87 lJ( 0 0 
88 vx 0 0 
81i1 VY 0 0 
lilO wx 0 0 
Iii 1 Wf 0 0 
92 
93 
94 UNCORRECTED CUTS ITO-FROM\ 
95 
96 TILE OUTLINE 1 2 
97 
98 AB OO'IX 0 0 
99 y 0 0 
100 a: OO'IX 0 0 
101 y 0 0 
102 a> OO'IX 0 0 
103 y 0 0 
104 CE OO'IX 0 0 
105 y 0 0 
106 EF OO'IX 0 0 
107 y 0 0 
108 FG OO'IX 0 0 
109 y 0 0 
110 GI OO'IX 0 0 
111 y 0 0 
112 HA OO'IX 0 0 
113 y 0 0 
114 XCHECK· 0 0 

115 YCHECK· 0 0 
116 
117 CORRECTED CUTS TOOL CORRECTION· 62.5 
118 
11 Iii TILE OUTLINE 
120 TILE 1 2 
121 AB OO'IX 0 0 
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Tiles template 

A B c D E F G H I J K L M 
122 Y(2 125 125 
123 BC G01Xl2) 125 125 
124 y 0 0 
125 CD <?01X 0 0 
126 YC2 -1 25 -1 25 
127 CE G01XIO\ 0 0 
128 y 0 0 
129 ET <?01X 0 0 
130 Yl-2l 125 125 
131 R3 G01X(Ol 0 0 
132 y 0 0 
133 Gt <?01X 0 0 
134 Y(2 -125 -1 25 
135 HA G01X(2l -125 -1 25 
136 y 0 0 
137 XCHECK- 0 0 
138 YCHECK- 0 0 
139 
140 CORRECTED GROOVE 
141 TILE 1 2 
142 MOVE Ai 
143 <?01X 63 63 
144 y 63 63 
145 STRAIGHT CUT IK 
146 <?01X 0 0 
147 y 0 0 
148 ARC CUT KL ABOUT T 
149 (?0Z)( 0 0 
150 y 0 0 
151 i 0 0 
152 J 0 0 
153 STRAIGHT CUT LM 
154 <?01X 0 0 
155 y 0 0 
156 ARC CUT MN ABOUT U 
157 (?0Z)( 0 0 
158 y 0 0 
159 i 0 0 
160 J 0 0 
161 STRAIGHT CUT NO 
162 <?01X 0 0 
163 y 0 0 
164 ARC CUT OP ABOUT V 
165 (?0Z)( 0 0 
166 y 0 0 
167 i 0 0 
168 J 0 0 
169 STRAIGHT CUT PO 

170 <?01X 0 0 
171 y 0 0 

172 ARC CUT QR ABOUTW 
173 (?0Z)( 0 0 
174 y 0 0 
175 i 0 0 
176 J 0 0 

177 STRAIGHT CUT RI 

178 <?01X 0 0 
179 y 0 0 

180 MOVEIA 
181 <?01X -63 -63 

182 y -63 -63 
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Tile& template 

A B c D E F G H I J K L M 
183 
184 I 

185 
186 GROOVE CHECKS 
187 TILE 1 2 
188 XCHECK• 0 0 
189 YCHECK· 0 0 
190 I CHECK· 0 0 
191 JCHECK· 0 0 
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Drawing Templ1t1 

A B c D 

Prtnt Drawing 

Print Data 

1 
2 ' 

3 
4 
5 
6 
7 
8 
g 

1 0 
11 Tile number 
1 2 />J(. 

1 3 AV 
14 EP< I 

15 f1( 

1 8 O< 
17 Of 
18 [)( 

1 g (}( 

20 EX 
21 ef 
22 FX 

' 
23 Pf I 

24 G( I 

25 G( 

26 1-1( 

27 1-1( 

28 IX 
2g IV 
30 IO( 

31 KY 
32 LX 
33 LY 
34 MC 

35 Mf 
36 N< 
37 rw 
38 ()( 

39 Of 
40 PX 
41 Pf 
42 ()( 

43 Of 
44 R( 

45 R( 

46 TX 
47 TY 
48 lJ( 

49 lJ( 

50 vx 
51 w 
52 WJI. 
53 wt 
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Orawi119 Template 

A B c D 
54 I 

55 
58 Dimensions 
57 I AB 0.000 
58 'EC 0.000 
59 <D 0.000 
60 CE 0.000 
61 NA 0.000 
62 CG 0.000 
63 DI i 0.000 
64 HI I 0.000 
65 AN 0.000 
66 PB 0.000 
67 ED 0.000 
88 FC 0.000 
611 VP 0.000 
70 M.. I 0.000 
71 i l'D I 0.000 
72 I 
73 
74 
H 
76 
77 I 

78 
79 I 

80 XOFFSET 204 
81 YOFFSET I 247 
82 AX I 

83 I AV ' 
84 I i~ 

85 I Er.' 
86 ex 
87 Of 

88 [}( 

u [)( 

90 EX 
91 EV 
02 FX 
93 Pf 
94 G( 

95 Of 
96 f« 
97 HI' 
98 IX 
99 IV I 

100 JXlnot used 
101 JYlnot used\ I 
102 I KX I 
103 I KY 
104 I LX I 

105 I LY 
106 I M< I 

107 I Ml' 
1 08 I ~ 

109 r'1f I 

11 0 ()( I 

111 Of 

112 PX 
113 p( 

114 ()( I 

115 Of 

116 A< 
117 RI' 
118 SX(not usedl 
119 SY(nol used\ 
120 TX 
121 1Y 
122 lJ( 

123 lN 
124 vx 
125 VY 
128 WJf. 
127 Wf I 
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Tilea_mcr hardc:opJ 

A 
1 
2 llaoroa dallnlUon 
3 
4 
s Tiie• Oeaianer 
& 1-..,..·F~~ 

7 ..FORMULAl"aFALSE",$"5231 

• ..GET.WINDOW111 
9 alFISASl•"TllH mer•\ 
10 • FOR MU &l"a TRUE",SAS231 
11 • ACTIVATE.NEXTn 
12 -ELSEO 
13 • CLOSEn 
14 -END.IFO 
15 ..GET.WINDOW/11 
u -IFIANDISAS15•"Tll" mcr",$AS23aTRUEl.,GOTDISA$811 
17 ..sHORT.M~ D~ 

11 •lnit Wortci) 
HI .New Workl\ 
20 aRETURNO 
21 
22 CIOM check 
23 •TRUE 
24 
25 
26 lnit Work 
27 ..ADD.BARO 
21 ..$HOW.BAR•~~· 
29 aADD.MENU• ..... "'"r.FMa mnl 
30 ..ADD.llENU•........,,Edt mnl 
31 aADD.MENUIM..-,Data mnl 
32 aADD.llENUIM-r,Oraw mnl 
33 aADD.MENU(Menublr,Win- mnl 
34 -cAlCULA TION(31 
35 .RETURN/I 
31 
J7 
31 Cl••r5aeen 
39 ...ECHOll'AlSE) 

40 .NumTilea+2 
41 ..GET.DOCUMENTlll 
42 alF1$AS40,.. I 
43 • SELECTrR20C5:R34C"&SAS40&",R49CS:R115C"&SAS40&",R120CS;Rt91C"&$AS40) 
44 • ClEAR131 
u -END.IFO 
41 ..fORMULA.GOTOl><lYD~711 
47 .CLEAR131 
u aACTIVATEISA$411 
49 ..SElECTllSASI) 
50 .RETURNO 
51 
52 
53 Dr•wina 
H aARGUMENTroraw d<",41 
55 aARGUMENTl"NC>lc:l'I d<".41 
51 ..ARGUMENTl"Groove d<",41 
57 • SELECTCISASI) 
SI • GET.CEllCS.1080) 
u • GET.CE l!i,1081 
60 • GET.CE .LJS,1082 
61 • GET.CEO I l!i,1083 
12 • GET.CE!.Ll!i,1084 
13 • GET.CEli.15,1085 
u - GET.CE Ll!i,ID88 
65 •GET.CE ll5,ID87 
II •GET.CE .I ,ID88 
'7 •GET.CE J ,ID89 .. • GET.C ,IOllO .. •GET.CE ll ,ID91 
70 •GET.CE .I ,Dll2 
71 •GET.CE J ,ID83 
72 •GET.CE J ,IDM 
73 •GET.CE• J ,ID95 
74 •GET.CE ,IOlMI 
75 • GET.CEL J ,ID97 
71 •GET.CE §,ID98 
77 •GET.CE 5,ID99 
71 •GET.CE 5D100 
71 • GET.C 5,D101 
IO •GET.CE 5,DI02J 
11 •GET.CE! .15,ID103 
12 •GET.CE J5,IOI04 
13 •GET.CE .15,DI051 
u •GET.CELI .15,D1081 
IS • GET.C"1 5,ID1071 .. • GET.GEL J5,D1081 
11 • GET.CR LIS DIOfll .. • GET.CEWS,IDI 101 
II • GET.CEW5,ID1111 
10 • GET.CEWS D1121 
11 • GET. '~' 5,Dtl31 
t2 • GET.C~ 5 ID1141 
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" U • GET.C 5,Dll51 
14 •GET.CE 5,1)1181 
15 • GET.ci ts,Dll71 
11 •GET.Cl 5,1)1181 
17 • GET.C 5,Dllll 
11 •GET.CE 5,Dl201 
II • GET.C 5,Dl211 

100 •GET. 5,DIZ 
101 • GET.C 5,1)1231 
102 • GET.C .t5,Dl24l 
103 • GET.C 5Dl25 
104 •GET. 5,IOl26 
105 • OET.c: llSDI: l 
IOI • GET.C • j i,IJ!i• 

107 •GET. I05I 
10I a GET. LI I059 
109 • GET.C ID60 
110 • GET.r ,llllll 
111 •GET.CE ID62 
112 • GETr• ID83 
113 

·GE~· 114 •GET 
115 •GET. 
111 •GET ,Pl; 
117 • GET.C I06I 
111 •GET.• .·-
111 • GET.C D71 
120 •GET."- D71 
121 • 
122 ..c:REATE.OBJECTll,"R1CI" SMl+SASUAIO+SASl."RICI" SA63+SASUA62+$A511 
123 ,.PATTERNSIO I I 3 2,2, II 
IU ..c:REATE.OBJECTl1,"RICl",SA63+SA51,IA62+1A51."RICl".SA65+1A51.SA64+SA511 
125 ePATTERNSIO, I I 3,2,2 II 
121 ..c:REATE.OBJECTll,"RICI" SA65+SA51,IA64+SA51 "RICl",$A67+SA51,SA66+$A511 
127 ePATTERNSIO, I 1,3,2.2.11 
121 elF(Nalcl'I die TRUEl 
121 ..c:REATE.OBJECTll,"RICl",SM7+$A51,$Mt+SA51,"RICl",$A61+SASllA61+SA511 
130 ,.PA TTERNSIO, I, l,3,2,2, II 
131 ..c:REATE.OBJECTl1,"RICl",$A61+$A51,SA61+1A51 "RIC1",$A71+SA51,$A70+$A511 
132 ePA TTERNSIO, I 1,3 2,2, II 
133 .CREATE.OBJECTll "RIC1" $A71+SA51,IA70+SA51 "RICl",$A73+SA51,IA72+SA511 
134 ,.PA TTERNSIO, I I 3,2,2, ll 
135 .a.sen 
131 ..c:REATE.OBJECTU,"RICl",$A67+SA59,IMS+IA51."RIC1",SA73+SA51,SA72+$A51l 
137 ,.PATTERNSIO 1 1 3 2.2.11 
131 -ENO.Fii 
131 ..c:REATE.OBJECTll "RICl",SA73+SA51.IA72+SA51,"RICl".SA75+SA51,SA74+$A511 
140 ,.PA TTERNSIO, I 1,3,2.2.11 
141 ..c:REATE.OBJECTl1, "RIC I" ,SA75+SA59,SA74+SA51."RI C1",SA6 l+SA51,SA60+SA511 
142 ,.PATTERNSIO I I 3 2 2 II 
IU -""~ clleTRUEl 
144 ..c:REATE.OBJECTl1 "RICl",SA77+SA51,SA76+SA51 "RIC1",SAll+SASUAIO+SA511 
141 ,.PATTERNSIO, I 1 3,2,2, ll 
141 ..c:REATE.OBJECTl4 "RICI" $All+SA51,SAIO+SA51,"RICl",$A63+SA51,SA62+SA511 
147 ,.PA TTERNS(O, I 1.3 .. 2.1 I 21 
141 ..c:REATE.OBJECTll "RIC I" SAl3+SA59,$M2+SA51,"RI Cl ".$AIS+SASl,SAl4+SA511 
1411 ,.PATTERNSIO,l,I 3 2,2.11 
150 ..c:REATE.OBJECTl4,"RIC1".SAl7+IA511,$Mt+IA51."RICl",SA65+SA59,SA14+SA51l 
151 ePA TTERNS(O 1 1,3 .. 2 I 1,21 
152 ..c:REATE.OBJECTll,"RICl",SM7+SA511,IAll+IASl"RICl",SAlll+SA5UAll+SA511 
153 ,.PA TTERNSIO, I 1,3,2,2, II 
15' ..c:REATE.OBJECTl4 "R IC1" SAll+SASl,SAll+IASl."RICl",Wl+SASI SAIO+SASll 
155 ,.PA TTERNSI0, 1 1 3 .. 2, I I 21 
151 ..c:REATE.OBJECTll "RICI" SAll+IASl.SAIO+IASl."RICI" W3+SA59 SAl2+SA511 
157 ePA TTERNSIO, I 1,3 2,2, II 
151 ..c:REATE.OBJECTl4,"R IC I" ,SAl5+SA51,SA04+SA51 "RI Cl" SAll3+SASUA12+$ASll 
159 ,.PATTERNSIO,I I 3 2,1 1,21 
110 ..c:REATE.OBJECTll,"RICl",SAIS+SASUA04+SA51."RICl".SA77+SASUA71+$A511 
111 ,.PATTERN~ I I 3 2.2.11 
Ill -ENO.FD 
1U 
114 -
111 ..U:IDr• die TRUE 
111 .cREATE.OBJECT I "RICI" SA61+SA51 SMO+SASl.S,"RICl",SA&l+SASl.S-IASl-401 
117 ..c:REATE.OBJECT I "RICI" SAl3+SA51,SA12+SASl-li,"RICI" SA63+SA51,SA12+1ASl-401 
IU ..c:REATE.OBJECT I "RICl",$A13+&&&a..& SAIZ+SASl,"RICI" SA63+~.SAl2+SA511 
111 .cREATE.OBJECT I "RICI" SA13+$A51.6 SAM+SA&l "RICI" SA63+Wl+40 $A64+$ASll 
170 elFlar- clleTRUE 
171 • CREATE.OBJECT I "RICl"SAI03+SAIW.IA102+SA51."RICl",SAI03+SA!ill+l,SAI02+SA511 
172. CREATE.OBJECT I "RICI" SAI03+$A51.U.102+1Alil-l "RIC1"$A103+SASll SA 102+$ASl+ll 

173· INTllSAll•IA103 SORT""' 
IU• CREATE.OBJECt t "RICI" SA103+SASI SAI02n•- "RIC1" SAI03+SASll+SA173.SA102+SAS&oSA1731 
175. PATTERNSll,11,1,11,31 
171. CREATE.OBJECT I "RICI" SAll+SASl,SAIZ+SMil-6. "RICl",$Al5+$A58,$A62+u.u. 

177• CREATE.OBJECT I "RIC1" SA17+SA51,$A~·-~ "RIC1",SA17+SASl,SA62+SA~ 
171. CREATE.OBJECT 1 "RIC1"SAll+IAlil,SA12.dilL£-"R1C1" SAll+SA51,SAl2+SA,.., 
171. CREATE.OBJECT I "RICI" SMt+SASI SAIZ+SASl-5 "RIC1",SAll+IA51,IA62+SAY.0 

110. CREATE.OBJECT I "RICI" SA13oSA&lo r;.SAl4+$ASI, "RIC1",$A63+SA51+25 SA04+SASI 
111. CREATE.OBJECT I "RIC1",IMl+SA&l-6 IMO+IA51. "R1Cl".IMl+SA5-.IMO+SA51l 
112. CREATE.OBJECT I "RICI" SMl+IA&l-6.IAN+SA51 "RICl",SMl+SASa.20,$AN+SA511 

113• CREATE.OBJECT I "RICI" SM1+SA51-6 Soaoisa~• "RIC1"SMl+SA5•20 $A64+$ASll 

114• CREATE.OBJECT I "R1CI" SMl+SA&l-6 $Al2+$•ED "RICI" SA&t+SASa.20 $Al2+$ASI\ 
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A 
115 .CNO.F() 
18& •IFIANDINotcn -TRUE Groove -TllUEll 
117. CREATE.OBJECTl1,"R1C1".SA77+SASM,ISMl4/2kSA51."R1C1",SA77+SASll+l,ISA64/2l+SASll ,. .. CREA TE.OBJECTl1,"R 1C1",SA77+SA58,(SA64/2kSASl-8,"R1C1 • ,SA77 +SA59,ISA64121+SA58+81 
119• MIN(SA7UA811 
110. CREATE.OBJECTl1,"RICl",$A77+$"58,ISM14/21+SA51+13,"RIC1",SA77+SA59,SAl89+SA58-5l 
111 • CREATE.OBJECTll "R1Cl",SA77+$"511,SA114+$"511-3,"RICl",SA77+$A59,SAM+SA51+4l 
182 .CNO.IFn 
113 -lF(Noldl-TRUEI 
114. CREATE.OBJECTll,"RICl",$M3+$A58+5,SM8+SA51,"R1C1",SA83+$ASll+IS,SA81+SA581 
195. CREATE.OBJECTl1,"RICl".SA77+SASll,SA114+SA51+9,"RIC1".SA77+SA59,SA64+$A58+351 
188. CREATE.OBJECTl1,"R IC1",SA75+SASll,SM14+$A51+5,"R 1C1",SA75+SASll,SA64+$A58+401 

117 • CREATE.OBJECTl1,"RICl",SA73+SASll.SMl4+$ASl+S,"RIC1",SA73+SASll.SA64+$A58+281 
11•. CREATE.OBJECTll,"R1Cl",SM7+$ASll,SA64+SA51+5,"RICl",SA87+$A59,SA64+$A58+401 
119 • CREATE.OBJECT(! "RIC1".SASS+SASll.SM4•SASl+S,"RICl",SA65+SASUA64+SA58+401 
200 .CND.IFll 
201 r• ~ 

202 !.ecHOIFAU!E• 
203 .CREATE.OBJECTll,"RICl",SAll+$A511+200,SA60+SA58-30,"RICl",SAll+SA511,$A60+$A58-301 
204 .PATTERNSll,1,1, I, l,1,31 
205 .CREATE.OBJECTl1 "RICl".SA81+SA59+200 SA60+$A51-30 "R1C1" SAl3+SA511,$A62+SASl-301 
20 ·PATTERNSl1,1,l,l,l 1,31 
207 ..cREATE.OBJECTn "RIC1",SA13+SA511+32,SM2+SA51+100,"RICl",$A13+SA511+32,SA12+SA581 
201 .PATTERNSll,1,1,1,11,31 
209 ..cREATE.OBJECTll "RICI" SA13+SA511+32,$Al2+SA51+100,"R1CI" SA85+SA511+32,SA14+SA581 
210 •PATTERNSll, I, I, I, I, 1,31 
211 .IF!Oroow -TllUEI 
212 .CREATE.OBJECTl1,"RICl",SAll+SA59-30,SA60+SA58-15,"RICl",SA11+SA511,SA60+SA58-151 
213 .PATTERNst1.1.1. I, 1, l,31 
214 .CREATE.OBJECT11."RIC1",SA85+SA511+15,SAIO+SA51·15."R1C1",$A85+SA511.SA60+SA58-151 
215 •PATTERNSl1, 1,1, I, I, l,31 
211 .CREA TE.OBJECTl1,"R IC 1",SA87+SA59+50,SA&O+SASI· 15."R1C 1",SA87+SA59,SA&O+SA51·151 
217 .PA TTERNS11, 1,1, I, I, l,31 
211 .CREA TE.OBJECT(l ,"R 1C 1",SA87+SA511+50,$A60+SA58· 15, "RIC I ",SA81+SA59,SA60+SA58-151 
219 .PATTERNSll, 1,1, I, 1, 1,31 
220 .CREATE.OBJECTll,"RIC1".SA91+SA59-15,SA60+SA51·15,"RICl",SAll+SA59,SA60+SASl·l51 
221 •PATTERNSll, l,l, 1, I, 1,31 
222 .CREATE.OBJECT(1,"R1Cl",SA63+SA511+20,SAIO+SASl·l5,"RICl",SA63+SA59,SAIO+SA51·151 
223 .PATTERNSll, 1,1, 1, 1,1,31 
224 .CREATE.OBJECTl1,"RICl",SA65+SA511+20,SAll4+SA58-30,"R1Cl",SA85+SA59+20.SAll4+SA581 
225 .PATTERNSll, 1,1, I, I, l,31 
221 .CREATE.OBJECT(l,"RICl",SA&S+SA511+20,SA14+SASl+l5,"RICl",SA116+SA59+20,SA64+SA581 
227 .PATTERNSll,1,1,1,1,I 31 
221 .CREATE.OBJECTl1,"R1Cl",SA61+SA59-15,SA60+SA51·10,"RICl",SA81+SA59-15,SA60+SA581 
221 •PATTERNSll,1,1, 1, 1,1,31 
230 .CREATE.OBJECT(1,"RICl",SA61+SA59-15,SA81+SA51+30,"RICl",SAll+SA511·15,SA81+SA581 
231 .PATTERNSll, I, I, I, 1,1,31 
232 .CREATE.OBJECTl1,"R1C1",SA61+SA59-15,SA84+SA58+50,"RIC1",SAl1+SASll·IS,SA64+SA581 
233 ·PA TTERNSll, 1,1, 1, 1, I ,31 
234 .CREATE.OBJECT(l,"R1Cl",SA61+SA59-15,SA64+$ASl+SO,"R1Cl".SAll+SA59·15,SA82+SA581 
235 •PATTERNS11,l,1, 1, 1,1,31 
231 .CNO.IFn 
237 •IF(Nolcll di• TRUE) 
238 .CREA TE.OBJECT(!, "RIC I ".SAIS+SA59+ 10,SMl+SA51· 100,"RI C 1" ,SAl5+SA59+ 10,SMl+SA581 
231 •PATTERNSll,1,1, 1, 1,1,31 
240 .CREATE.OBJECT(l,"R1C1",SMiS+SA511+10,SA64+SASl+IS,"RICl",SA116+SA51+10.SA64+SA581 
241 .PATTERNSl1,l,1, I, 1,1,31 
2'2 .CREATE.OBJECT(l,"R1Cl",SA65+SA59-60,SA64+SA51+32,"R1Cl",SAl5+SA59,SA64+SA58+321 
243 .PA TTERNSl1, 1,1, I, I, 1,31 
244 .CREATE.OBJECT/1,"RICl".SA65+SA59-60,SA64+$A51+32,"RIC1".SA67+SASll,SA61+SA58+321 
245 .PATTERNSll, 1,1, I, 1,1,31 
241 ..cREATE.OBJECTll,"RICl",SAB7+SA59+30,SA61+SASl+22,"RIC1",SA87+SA59,SA66+SA58+221 
247 •PA TTERNSll, 1,1, I, 1, 1,31 
248 .CREATE.OBJECTl1."RIC1".SA73+SA59-15,SA72+SA51+22,"R1Cl",SA73+SA51,SA72+SA58+221 
2411 •PATTERNS11,1,l, I, l,1,31 
250 .CREATE.OBJECT(l,"R1Cl",SA77+SA59-100,SA72+SA51+32,"R1C1",SA77+SA59,SA72+SA58+321 
251 •PATTERNSll, 1, I, I, 1,1,31 
252 ..cREATE.OBJECTl1,"RIC1".SA77+SA59-100,SA74+SA51+32."R1C1" SA75+SA511,SA74+SA58+321 
253 .PATTERNSll, l,1, 1,1,1,31 
254 .CND.Fll 
255 
251 r• 

257 .CREATE.OBJECT(9,"R1Ct",SA11+SA59+2.SA60+SA51+2."R1C1",SAl1+SA511+14,SA60+SASl+161 
251 •TEXT.BOllrA"1 
251 .PATTERNSl2.1 1, 1,FALSE.1.1 1,2,FAL-• 
280 .CREA TE.OBJECTl6, "RIC 1",SA13+$"59-2,SA82+SA58+2, "R 1C 1",SA13+SA59-14 SA62+SA58+ 181 
211 .TEXT.BO•m 
212 .PATTERNSl2,1Il,FALSE,l,l1,2,FALSEI 
213 .CREATE.OBJECTle,"RIC1".SAIS+SA59-2.SA64+SASa.2,"R1Cl",SA65+SA59-14,SMl4+SA58-tll 
284 •lEXT.-'IIr'I:~ 
2U •PATTERNSl2, 1, 1, 1,FALSE,I, I, I ,2,FAL-• 
2H .CREATE.OBJECTIS,"R1C1",SA75+SA59+2.SA74+SA51·2,"R1C1",SA75+SA511+14,SA74+SA58-161 
267 •TEXT.--i•~ 
211 .PATTERNSl2,l,1,1,FALSE,1,1 U,FALSEI 
211 -lFINoldl_T_• 
270 ..cREATE.OBJECTRl,"R1C1",SA67+SA511+1.SA61+$ASl+l,"R1C1",SA87+SA511+13,SA66+SA61+151 
271 • lEXT.80Xf"'l11 
272 •PA TTERNS12, I, I, I ,FALSE, I, I, I .2,FJ.Lst,1 
273 .CREATE.OBJECTl8 "RIC1",SA69+SA59+1.SA68+SA58-1,"RICl"SA69+SA59+13,SA88+$"51-151 
274 •TEXT.BO~ 
275 •PATTERNKl,1,1,1,FALSE,1,l,l,2,F,\UIEI 
271 .CREATE.OBJECTIS "RICI" SA71+SA69-1 SA70+SASa.1 "R1C1" SA71+SA59-13 SA70+SA58-151 
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A 
277 aTEXT.BOlll"'n 
271 ..PATTERNlll2, 1, 1, 1,FALSE, 1,1 1,2,FALSEl 
271 .CREATE.OBJECTl8, "RIC 1".SA73+SA50-1 ,SA72+SAS8+ I, "RIC I ".SA73+SA50-13, $A72+SA58+ 151 
210 ·lEXT~ 
211 ..PATTERN!MZ,1,1,1,FALSE,1112 FALSEl 
212 -END.Fil 
2U alR-cllaTRUE) 
214 .CREATE.OBJECTll "RIC1" SAl1+SA51.SAIO+SAS8·5,"RIC1",SA11+SA50-12.SAIO+SAS8·11l 
215 aTEXT.BOlll"l\"I 
211 ..PAnERNllG!,1,1,1,FALSE,1,11.2 FALSEI 
217 .CREATE.OBJECTl8,"RICl",SAl3+SA58+1,SAl2+SA51,"RICl",$Al3+SA511+13,$Al2+SA51-141 
211 •TEXT.BOXn., 
211 ..PATTERNlll2,1,1 !,FALSE.I I 1.2.FALSEl 
290 .cREATE.OBJECTl8."RICI" $AIS+SAS8+1,SAl4+1AS8,"R1Cl",SAl5+SA511+13,SA14+SA51+141 
211 .TEXT.aoxnn 
212 ..PATTERN1112, 11, I FALSE. I, 11 2 FALSEI 
293 .cREATE.OBJECTl8 "RIC1",$A17+SA51,SA86+SA58+1."RIC1"SA17+SA511+12,SA86+SA51+15l 
214 •lEXT.~ 
215 ..PATTERN!MZ, 1, 1, 1,FALSE. I, 1, 1,2,FALSEI 
211 .cREATE.OBJECT18,"R1C1",SAlll+SA51,SAll+SAS8+1,"R1Cl",SAl8+SA50-12,SA18+SA58+15l 
217 ·TEXT~ 
211 ..PAnERN812,1,I I FA"'" 11 1.2 FALSE! 
219 .CREATE.OBJECTlll,"RICI" SAl1+SA!il-2,SAIO+SAS8,"RICl",SAll+SA50-14,SAIO+SAS8+14l 
300 •TEXT.BO:an-o 
301 ..PATTERNllG!,1,1.1,FALSE,1 I l.Z.FALSEI 
301 .CREATE.OBJECTlll,"R1CI" SAl3+SA50-2,SAll2+1A58,"RIC1",SAll3+SA50-14,SA12+SASl-141 
303 .TEXT ... ~ 
304 ..PATTERN~~.1.1 1,FALSE.1112 FALSEl 
305 -CREATE.OBJECTlll,"RIC1" SAl5+$Alill,SAl4+SA58°5,"RIC1",SAllS+SAS8+12,SAM+IAlil•llll 
30I .tEXT.eaxnn 
307 ..PATTERN""' I I l,FALSE,1,1 I 2 FALSE! 
30I .CREATE.OBJECTlll,"RICl",SAI03+SASll0 1,SAI02+SAS8+1,"RIC1",SAl03+SA511·13,SAl02+SAS8+1S\ 
308 aTEXT.BOXnn 
310 aPATTERN!MZ,1,11,FALSE,I 11,2,FALSEI 
311 aENO.FO 
311 alFIANOINolch cllaTRUE,<nove cllaTRUEll 
313 ..MIN(SA70,SA711) 
314 .CREATE.OBJECTlll,"RICl",SA77+SA50-5,SA313+SAS8·10,"RICl",SA77+SA511+6,SA313+SAS8°241 
315 ·TEXT.BO•m 
311 ..PATTERNS/1,1,1,1,FALSE,l,l,1 2 FALSEI 
317 -RlRMAT.FONTI. ~ 
311 aENO.FO 
311 
320 ~· 
311 .CREATE.OBJECT Ill "RICI" SASl+INTISA113121·14,SA60+SAS8·23,"R1CI" SA58+1NTISA6312l+l4 SA60+SAS8·37l 
321 aTEXT.BOXISAl0e&-5-, 
323 .FORMAT.TEXTn,1,0.,TRUEI 
324 ..PATTERN!llli! 111 FALSE,1 I 1 2 FALSE) 
325 •INTISA64121 
321 .CREATE.OBJECTl6,"RICl",SAll3+SASl+23.SA62+SA58+SA325·14,"RICl",SA63+SA51+37,SA112+SAS8+SA325+14l 
327 • TEXT.BOXISA107a-a., 
321 ..FORMAT.TEXTll, 1,2 .. TRUE) 
321 aPA TTERN812, I, 1, 1,FALSE, I, 1 1,2,FALSEI 
330 .IFIGroow clla TRUEl 
331 alNTf(SA811·SA87)/2) 
332 .CREATE .OBJECT!&, "RIC I" ,SAl7+1A511+$A331°14,SA60+SAS8·1, "RI C1",SAl7+$ASll+SA33I+14,SA60+$AS8·221 
333 aTEXT.BOXISA120&-a-, 
334 .FORMAT.TEXTll, 1,0 .. TRUEI 
335 •PATTERNSl2, 1,1, l,FALSE,l,I 1,2,FALSE) 
331 .CREATE.OBJECTl8,"RICl",SA61+SA511-40,SA60+SAS8-l,"RIC1",SA81+$A51-6ll,SA60+SA58·221 
337 aTEXT.BOXISAl10&-a-, 
331 .FORMAT.TEXT(l,1,0, TRUEl 
331 ..PATTERN!MZ, 1, 1, I ,FALSE, 1, 1, 1,2,FALSEI 
340 .CREATE.OBJECTl6,"R1C1",SA63+SA51+20,SA62+SAS8·8."RIC1",SA63+SAS8+48,SA62+SAS8-221 
341 aTEXT.BOXISA115&-a-, 
341 .FORMAT.TEXTl1 1,0 .. TRUEI 
343 aPAnERN!llli!,1,1,l,FALSE.111 2,FALSEl 
344 .CREATE.OBJECTll,"RICl",SAI03+SA51+5 SAl02+SA58·10,"R1C1" SA103+SA58+30,$AI02+SA51·241 
341 •TEXT.BOXISAl11&-a-i 
341 .FORMAT.TEXTll,1 O .. TRUEl 
347 ..PATTERN~J,11,1,FALSE,1 I 12 FALSEI 
341 .CREATE.OBJECT/l,"RICl",$A65+SASl+13,SA84+SAS8°30,"R1C1",SA65+SA58+27,SA84+SAS8°S8l 
341 -TEXT.BOX/SAi 11a-a-i 
350 .FORMAT.TEXTll,1.2.,TRUEl 
351 ..PATTERN,.,,,,1,1,l,FALSE,1,l,12,FALSEI 
352 .CREATE.OBJECTll "R1C1" SA81+SASO-l.SA88+SA58+10,"R1C1",SA81+SAlill-22.SAl8+SAS8+381 
353 •TEXT.BOXISA11'a-a-i 
354 .FORMAT.TEXTlt,1.2..TRUEl 
351 ..PATTERN~J 1,1,1,FALSE.1,1 1.2.FALSEl 
351 •INT(ISAl2•SAl41/2l 
357 .CREATE.OBJECTll,"R1Cl",SAl1+SASO-l,SA14+SAS8+SA356°14,"RICl",SA81+SAS0-22.SA14+SAS8+SA356+141 
351 .TEXT.BOX•~1186-&-i 
351 .FORMAT.TEXTll 1,2.,TRUEI 
310 ..PAnERN,.,,,,1,1 !,FALSE 1,11 2 FALSEl 
311 aEND.FO 
311 alFINoldtcllaTRUEl 
313 alNTISA7712l 
3U .CREATE.OBJECT16,"RIC1",SA75+1A58+SA363-14,SA74+SAS8+23,"RICl",SA75+SA58+SA363+14,SA74+SA58+371 
315 .TEXT.BOXISA113&-&"""1 
3H .FORMAT.TEXTll 1,0.,TRUEI 
317 •PATTERN,....<, 1, 1, 1,FALSE.I, 1, 1.2,FALSEI 
311 .cREATE.OBJECTlll "RIC1" SAll7+SA58+20 SMl+SAS8+24 "RIC1" SA87+SASl+48 SAllll+SAS8+101 
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A 
368 .TEXT.BOXISAltta-&-i 
370 .FORMAT.TEXTl11 0, TRUE! 
371 .PATTERN!ltl!,1,1, l,FALSE,11.1.2.FALSEl 
372 •INTUSA65•1All7112) 
373 ..CREATE.OBJECTll,"R1C1",$A117+1ASll+$A372-14,SA64+SA58+37,"RIC1",$All7+SA59+SA372+14,$A64+$A58+231 
374 •TEXT.BOXISA10B&-&-i 
375 .FORMAT.TEXTl11 O,,TRIJEI 
371 .PATTERNSl2,1,11,FALSE,1 I I 2,FALSEI 
377 ..CREATE.OBJECTlll,"R1C1",$Al5+$ASll+4,IA61+SA58-80,"R1C1",$A65+SA59+18,$A68+$A58-1081 
371 •TEXT.BOXIU.108&-&-i 
371 .FORMAT.TEXTll 1.2.,TRUEl 
310 .PATTERN!ltl!,11,1 FALSE.I I 1,2,FALSEI 
311 -END.Fil 
311 -END.FO 
3U ..sa.ECTl"R1C1"1 
314 
315 
3H 
317 
311 
311 
3IO 
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I c D E 
1 
2 --· ... ·-3 
4 
5 Print drawina Fii• Edit 

• ..seLECTCl$M11 
1 ..sET.PRINT~ fMw WOfll lhlo 

• JIAQE.SETU ·~1uaaU1HMIO&ll",-..... FALSE,FALSE,TRUE,TRU9 .oPEN...-.-• uou~ 

• ol'AINTO ·~ 1-"o:Tlo:IMI\ 

1 0 -DELETE.NAME ~ Neri 
11·-.. ~ ·-- Cut 
12 .QPEN'M ..CUTn 
13 '""""' ·~~ 

14 Print data 
15 """' aoae Paste 
11 ..sELECTrAl 1C3:A71C4"1 JIASTEn 
17 ..sET.PlllNT .AA~-· ·- ·~=~ 

I I JIAQE.SETUPl"&CllUB&UIFlll&10ID' .. 1.1 FAI ""'TAUE,FAUJE.f&I ~ ,. ol'AINTO -- r~ 

20 ..oELETE.NAMEn·nN Alea"! .s.i.ven J;".,()f"'fft 

21 ..seLECT11$Mll ·- ·~=-UA 

22 ·~~~ 
23 -aa Cli=ard. 
2' .s.\VE.AS?n ..sHOW.aJPBOAADn 
25 

,_ 
·~=~ 

21 
27 Proo.,. er- Exc:al 
21 • ARGUMENTnwe .....-,11 ·-
2t • ARGUMENTrN.,,. we",21 of'ORll' ..... -FALSE" ,$D$4111 

30 • AFIGUMENTrN- di" 21 .oET.WIYlflWnl 
31 • AFIGUMENT~~.11 .iR$D$30.."TllH mcr"l 
32 • ne....-+2 • FOAM1" ~.TRue•.SDMt\ 

33 . ..... • ACTIVATE.NEXTn 
34 • .a.sen 
35 • FORMULA.GOT~- -"'IR48C"aaal32&":11111C'l"~u~ •Cl.Olli! on 

31 • COPYn .END.F 
37 • FORMULA.GOTO(- cl'&"'IR11C4"l .oET.Wl ~· 
31 • PASTE.SPECIAL.13. t,FALSE.F"1.~ $0$37a"lllea mcr.SOS4t. TRUEl .. GOTntSOS3011 
31 • IFISG$31-FALSE FOAMULAllSOSl&12.ISOS2tll J.IX).R All\ 

'° • 295.075/CI .&HOW.BARiii 
41 • FOAMULA.FILLI".T11e1 mcrlll40C2" ISDH2:SDSl271 .cAl.CULATI~t1 

42 • SELECTllSDll2:SDS291 II 
43 • COPYn ·-
44 • SELECT•~~· mACllVATE.NEXTn 
41 • PASTE.SPECIAl.13.4,FALSE,F&• -· -41 • SELECTCISOl3Cl:SOS451 
47 • COPYn 
41 • SELECTllS0$11121 0-Cllldl 
41 • PASTE.SPECIAl.13,4,FALSE,FA -· ..FAUE 
50 • SELECT•.....,.SDl53l 
51 • COPYn Exit 
52 • SELECTllSDSl20l 
53 • PASTE.SPECIALC3.4,FALSE.FA' -· .i:ol!M' • &'".f'Al.SE" .soaa1 
54 • CAU:ULATEDOCUMENTO .oET.WINOOWl1\ 
55 •RElU-• .iFISDS54•"lllea mcr"l 
SI 

, 
• FOAM1 • ..... TRUE",IOl&ll 

57 • ACTIVATE.NEXTn 
51 '""" 
59 Clear Or1winll· •CLO~ 

60 .sELECTllSCSIO:IOS127l -END.""' 
61 .CLEAAC3l .oET.WINDOWlll 
&2 .sELECTllSMll AN~~t•"lllH mer $0$6&.TRUEl •• GOTnl$0$54\I 

13 ,_ .. _, 
14 .aurrn 
n ·-
" 17 Qola Cllldl . .. .FALSE .. 
70 
71 
72 
73 
74 
75 WlndaW 
71 
77 Activate 

71 
7t mACllVATE.NEXTn 

IO .oet 
11 .FISDUo.a.ACTIVATE.NEXTnl 

12 
13 
14 
15 .. 
17 Activate wa .. .. .ACTIVATE.NEXT" 

IO .oET.DOCUMENTCll 
91 ..aET.CEWl7 ilAll'" 

12 OR~~~~ IDS01-~GOTO"'Dllll" 
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• 8 c D E 
93 '..RPTllANI\ 

14 
95 
11 
17 Activate dr 
91 ""' 
u -ACTIVATUEXTO 

100 .QET.DOCUMEHTC31 
101 ..QET.CEW17,ISASll 
102 -IFIORISDS1oo.3,SDS101c1001,GOTOISDS9911 
103 

,_., __ 
104 
105 
101 
107 
101 
101 
110 
111 
112 
113 
114 
115 
111 
117 
111 
111 
120 
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F 
1 
2 
3 
4 
5 Data 
I 
1 ln1en d•t• 
I 

• ..otALOG.BOXllr•.i ..,, 
10 ..FfNClTISF111-FALs1m 
11 • FORMULA.FILI.r.FALSE"--:$0$371 
12 • a...-n 
13 • FORMUU.r-RllCl",SFS931 
14 • IFISFl83.121 
11 • DIALOG.BOX,_ •I 
11 • IF<NOTis-15-F,&J ""'' 
17 • IF(SOS441:.$0$91 
11 • ALEATnne _ ol_ at ... troralncrwmontnual be -- tllllntllll- ........ ol lile•"31 
11 • QOn•-~151 

20 • END.IFll 
21 • FORMtJU.1".TAUE" SGS381 

22 - FOAMLILAl"•Tllft mcrtA41C15",ISCU41 

23 - FOAMU Al"•llle• mcrtA42C15",ISCS271 
24 • FOAMULAl"•Tllft mcrtR43CIS" ISC$301 
25 • FOAMUl..At'•Tllft rncrlll44C15",ISGS421 
21 • FOAMULAl"•Tllft mcrtR4SC15",ISG131il 
27 • FOAMU &'"•Tiie& rncrtfl48Cl&",ISOS381 
21 • FOAMU' &'"•lllM mcrlR47C15" ISJllSI 
21 • FOAMUl..At'.TllM rncrlAICIS-lllea rncr1M8Cl5",ISQ$41l 
30 • ENO.IFO 
31 • ENO.IFO 
32 • IFISFS93-151 
33 • OIALOG.BOX(Oroave Obi 
34 - IFCNOTllFl33-FAl,...11 
35 • FORMUUll"• TAUE",S0$371 
31 • FORMU &'"•TllM rncrlR511C15",ISCS261 
37 • FORMLILAt'•TllM rncrlRIOC15",ISCS341 
31 • FOAMUUll"• TilM rncrlR8IC15", ISC$331 
31 • FOAMULAl"•TllM rncrlRll2C15",ISCS251 
40 • ENO.IFO 
41 • ENO.IFO 
42 • IFIOAISFS93-12,SFS93a151,GOTOISFIMll 
43 • IFfS0$411.soS91 
44 • ALERTt-Tne - ol - ol tllll !rant Ina- must be omaM• ..... tllll kll.i - of li.o",31 
45 - oo~• 
41 • END.IFll 

47 - FOAMULAluu.a•. MATERIAL: "&M.-l,1$AS21 
41 • FOAMULAr-Tiie• mcrlRIC15", ISOS Ill 

48 - FORMUU.r·Tlle• rncrlRIOC15",ISCS151 
50 • FORMULAl"•Tlle• rncrlR11C15",ISCSl61 
51 • FORMULAl"•TllM rncrtR12C15",ISFS151 
52 • FORMULAl"•TllM rncrtR13C15" ISFStel 
53 • Nt.mTllM+2 

54 - SELECTl"R20C4:R34C"&SFS53&",R49C4:R91C"&SFS531 
55 • ALLRIOHTO 
51 • SELECTrA9SC4:Rl15C"&SFl53&" R120C4:Rl91C"&SFS531 
57 • ALL.RIOHTn 
51 • Nimn-3 
51 • FORMULA.ALLr.R:mc-1!.R42C7","1130C"&SFS58&":R30C"&SFS53) 
60 • CALCULATE.OOCUMENTO 
61 • IFISGS38-TAUEI 
12 • SELECT ("1131C"&SFS631 
13 • FORMUI M"..cl",$FS8 II 

14 - FOAn. ~.1 Nunl'llftl 
IS • """"" TIVE.CELLnl 
II • AR<Ua FSET•ac:TIVE.CELLll, t Oil 
17 - ACTIVE.CE ~n+OFFSET·- TIVE.CELLn, t 01 

••• SFS85+SFSff.SF1'7+SFSlt .. - FOAMUU.r-F181C1",$FSltl 
70 • SELECTIOFFSETIACTIVE.CE 1no.111 

71 • NEXTO 
72 • IFISFSlb0.011 
73 • ALEATr ,,,. ---o1 lleM llM lo ...,. ... - - .. .,_ natc:n ....... 1n1o ... - rlldlua. Pleaae c:lled< vo" dalll and .... 111 
74 • END.IFR 
75 • END.IFO 
71 • SELECTllSASll 
11 -END.Fil 
71 
71 
IO Check.....-
11 -SFSU 
12 
13 ._ ... .. .otALOG.BOX(lnl.i ..,, 

15 .. ASFIM-FALSEl .. .ao .. ~1111 
17 -ELSEO .. a FORMU &1".A114Cr,$FS931 .. • OOTOISFS141 
10 -END.Fil 
11 
12 Daloa nu-
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15 
u Goto Ill• 
17 -
11 ..otALOG.IOX ~ ... I .... 

100 • IFIOR Tlff,IOMl<Oll 
101 • ALERT .. - tie nLIT'lber. Do._. w_,. to.,, aminr,1\ 
102 • IFllFSIOl•TR1JR 
103• GO~• 
1U • ELSE 
105 • GO =-FS1211 
101 • ENO.I 'II 
107 •END.IF 
1 GI • IF~ 11.11 
1 OI • FORM ''"-Z0-,IFSl21l 
11 O • ELSE.IF 7tJi 
111 • FORM "'-48".IFS1211 
1 1 I • ELSE.IF 71"31 
11 3 • FORM ''" ..... IFS1211 
11 ' • ELSE.IF 11-'1 
115 • FORM U-.120" IFS121l 
111 • ELSE.IF 102..iil 
117 • FORM "- ""•l41" IFSl211 
111 •END.IF~ 
111 • SELECTl"R"&SFS12A"C"&-~~· 
120 -END.FR 

121 
123 
12' 
125 
121 
127 "'-• 10 ...... 
121 .20 
121 
130 
131 
132 
133 C•lculate 
13 4 oCAL.CUIATEDOCLUENTll 

131 
137 
131 
131 
HO 
U1 
U2 

111 .. _ - hl•dcopy 

F 
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0 H 
1 
2 I 
3 ; 

4 
5 Dr•• 

' 7 DrlW Tiii 
I 

• oGET.CEW17,ISAStl 
10 ..iF(SGSlb2001 
11 . ALERTl"TM 1dlv1 - II - 1 --· 1'111• ICtiYlll .. -- hm - I - tau 111 ... 
12 • RElU INI\ 

13 oEND.F 
14 .INPUT 'IJl'IW 1111 -:",1 "0raw Tlll",1\ 
15 .IF•-~ $GS14oFAl-.. 
11. IF/OR llKA14cO,$GS14:.Num-11 
17 • ALERT"""""9Cll ate -· Do ..., •- • n 1na.,'/", ll 
11 • IF1$GS17• TRUl:I 
11 • G0·~--141 

20 • ELSEn 
21 • GO·---~· 

21 • END.IFD 
23 • ENO.IFn 
24 •GET. II 
25 • FORMUlA.G0·---~~14+21 
21 • GET.CEll.ISI 
27 • OPENl"tll'_.I 
21 • GET.DOCUMENTl11 
21 • Pr.., .. D<l-•$GS14,SGS24.SGS21.IOl2ll 
30 • Or-TRUE.S0$38,$GS371 
31 • Cle• Or1wi,..11 
32 oEND.FO 
33 ,_"_' 
34 
35 Chec*a for notch Ind - dr-
31 -FALSE 
37 -FALSE 
31 
31 
40 
41 
41 
u Ov«Uo 
44 .fORMLL&r.FALSE",$0$1011 
45 .GET.CEW17.ISAS11 
41 .tFIS0$46"'2001 
47 . ALERT.-.- •div• ·- .. - I --· Pin• ICllYlll .. -- •om - I ·- ,. ...... di 

" • OQTO<SG11131 

41 oEND.Fn 
so D~ 

51 .oET.DOCUMENT111 
52 -OPENl"Dl'IWina"I 
53 .oET.DOCUMENTlll 
5' J.CTIVA TEISGS511 
55 .tFISGS101.FALSE) 
51. INPUTnnun 1111 ....-of.,. -11111., 111 crown. Pr• .. c..,.., to exiL",1,,,. ... •• ........... 11 
57 •IF/NOT 
SI • IFIORl$GS56c0,$GSSS:.Num1'111111 
59 • ALERTMncarncl 1111 -· Do _, wMI 111 n aaoin?", I) 
GO • IF(SG$58. TRUE\ 
11 • GOTIJISGSSSI 
12 • EL.SEil 
13 • GOWISGS831 

••• END.IFn 
u. END.IFn ... FORMULA.G0•~-1••lfl54C"UQSY.2l 
17. GET.CE '"'' 

••• F0RUULAl"•TRIJE•,SGS1011 .. - p SGSSUGSSl ,SGS53,IGS67l 
70 •ELSER 
71 • GO ~~· 
7Z •ENO. Fil 
73 

, __ , 
74 • INPUTn,.lfl 1lle .....- of 1lle ate ID Ill drawn. Pre .. C- to ex~.· I ,n, ... ate .....-.11 
7S • IFINOT-a74of•• -" 
71. IFIORISlD74cO,SGS74:.NumTllllll 
77. ALERTl"lncarncl ate --· Do ....., -·lo n aaoin?", 11 
71 • IF~ l'l'eTRUEI 
71 • GO $GS741 
10 • ELs> 

11 - GO °""""' u. END.I n 
13. END.IF 
14 • ELSEO 
IS• Cl••·D<I-· .. .oo~·· 
17 - ACTIVAlEISGS531 .. • END.IFn .. • Pr-- 0o:o-~GS74,SGS&1,SGS53.$G1171 

IO .END.Fn 
11 ..or-FALSE,$GS3UGS37l 
tz .ao~· 
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G H 
83 I ..RlillJANl'I 

84 
85 
81 
87 
81 
81 

100 lnaen first ~le 

101 ~ 
102 
103 
104 
105 
1DI 
107 
108 
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Tiltl_llllil' hlr11G1111Y 

I J K L .. N 0 p Q 

1 
2 01111- ....... detlnlll ... 
3 
4 lt•m • Iv width llelnllt text init/result 
s 
• 
7 TilH Lev out 
I 514 311 TIIH Levout 
I 7 158 47 70 NumTlln 2 
10 • 158 87 70 x 
11 • 158 127 70 y 
12 1 341 87 70 x-
13 8 341 127 70 v-
14 5 30 50 117 25 N.- of''-• 
15 5 41 90 x of ftrll 111• 
,. 6 41 130 y of ftrll 111• 
17 5 211 90 x-
11 5 211 130 v-
,. 5 47 170 AU. VALUES MUST BE ENTERED IN lollLS. 
20 103 120 285 No1c:ft 
21 5 251 225 lol•1••1•1 
22 5 25 225 Tille 
23 103 310 285 Groove 
24 1 150 340 64 (]( 

25 2 210 340 64 Clnml 
21. 65 222 171 Tltla 
27 • 321 222 171 lolatart•I 
21 
21 
30 Nolcll OeocriDtian 
31 70 92 635 360 Nold> DeocriDUon 
32 5 81 29 Wldtll 
33 5 481 29 Den .. 
34 5 401 74 0.D .. tncremenl 

35 5 41 139 Initial ollitt 
3& 5 65 111 Nolen lllill for front 11111 
37 5 8 231 N.- GI 1i.1 at Ill• Ina-
31 5 371 191 Notch olill tor bac:ll lllllt 
31 I 175 300 64 (]( 

40 2 390 300 64 Clnml 
41 7 144 26 60 Wldtll 
42 7 543 28 60 ~ .. 
437 144 134 60 lnitlll 511111 
44 • SU IH 60 Nolelt olill tor b•c:ll nlllt 
45. 254 IH 60 - - tor front 11111 
41 7 254 231 60 N.- of II•• at Ill• Iner-
47 I 543 71 60 o.-- Increment .. 
41 
so Ol'oave Deocrinlon 
S1 410 331 Or-
S2 5 60 60 E..._ to - IFtrlt Til9\: 
53 5 211 60 Tnn 
54 5 212 95 Side 
SS 6 190 130 Bottom 
51 5 60 190 BendRadklo 
57 1 150 280 (]( 

SI 2 210 280 64 C.nmt 
51 7 255 57 85 Ton 
60 7 255 92 85 Side 
11 7 255 127 85 Bottom 
&2 7 160 187 85 BendRldklo 
13 
14 
15 Goto-.. 522 291 Goto Tll• 
17 5 50 55 Gol0111enumber: 

II 7 190 52 40 NumTlle 
u 6 50 190 REMEUBER THAT ALL VALUES ARE EXPRESSED IN 1111' 
70 14 275 47 180 Ill Siied .... : 
71 11 
72 12 Gerwm1Da111 
73 12 eo.dMte ~11 
74 12 ~cut• 

7S 12 corrected cull 

71 12 Conec:lecl Grmve 
77 1 110 240 64 (]( 

71 2 210 240 64 c.nmt 
71 
10 
11 
12 
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A s T u v w x 
1 
2 M..- deftnltlan 

' 4 --·nd N-Gl.........-m•a< Sllortc:UI ~IYI S111tua bor me1Nma CUiiom helD toDic 

5 

• 7 Fiio 

• NIWWDlll- New wort.; n Createa • new wartw-

• . 10 ~ '~ 0 ,,._ ... ---11 Close aoae • Clo"" tie aelive work.-
12 Sllve Sllve • S8Yff ... •c:liY•--
13 SllveAa. •• Save •• h DI-·-- tte uve dialoa boa 
14 . 
15 Retum to Ellcel Ellcol r Oulll .,. tile ••- •DDlic .. an 
11. 
17 Quit Exit 0 Oulll Excol 3.0 
11 ,. 
20 
21 Edit 
22 \hla U'lllo z U-11•1nt......,._ 
23. 
24 CUI Cut x A-11conlllllot1llecleClcoila 
25 ........ ,.,,_, c r........,H.....,,cella 
2' P•llo Pule v P•- diDbolrd cant ... 
27. 
21 8""w CUobft•rd a1~""' ShoWa diobo•rd con-
21 
30 
31 
32 Dal• 
33 Insert Dall ... Insert data I si- dl•IOG box ID Insert d818 
34 C.lc:Ul8t• Now c ......... I P---••• cha.._. .,,,. ___ M docwnent 
35 
31 GotD lite .•• Goto tll• Q S.1- IDecifled cell 
37 
38 
39 
40 Dr•w 
41 0r- Tiie ..• Craw Tile d Drawe and .. ,. ttw uaer Drinl a tile 
42 . 
43 OVtrillD TllH ... OV-D lo 0ra- • Hieelod - ...... - an IDD ot lh• 
44 
45 .. 
47 Wlndcw .. -···· next Activate • ActivatH ne1t WlndoW 

48 . 
50 Ac:tivat. n.xt wont..,_ Activate WI Activate• Miit • .,,.ahrMt 
51 Activate next draw...., Acllv•t• dr Actlvataa next drawina 
52 
53 
54 
55 
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How to re.ad th~ flow c.hart 

The f o I lo win~ ~~ m bo ls hav~ been u~e.al: 

~ (sT~PJ 
I 

1 re.t 

~cp 

M ac.ro o-a'lh'-
1~ i_ I 

T~is s~m6ol is tJ.seJ when 
He md<:.iritosh pe•forl')')~ an 
ac.t\on . 

rJi..~. h h ... \wa/$ to w~om tht2 
~<..ti on I~ ~fe,l'"t""e.d 

'N\iC.i"Of\"'m.t.. 
re_~ I 

i '\ thsl name .al'd 
H~ re?erenc.R. a~ t1 

rt)a;c.ro Wh i c...'h ~ S 

~vet"1t14~,ll~ '-dlled 

!his s~ rnbo l is 2n IF c.omma11d 

-ni~ s~mbol is. v.~e.d whevi t1-u. l.\Si?r 

. i~ re9\.l.ired b, _eokr SoMtt il\for~1)}n 
t"1ro~ ~ tk ke.~ l.:oarbt 

T~ese ~(3mbols are. v.sed to 
c.on ne.c:.t two diVfiec-e<1r ?Bte.s <1f 

_ th.e._f/ow- f.hcJr t_ 

~1 



1 ...... ····· 
.. START 

C/o.x:s._e.ver~ _ _ _Ti r~_ Pe<;i.iarie.r .. 
pr~viou..s/~ cpeoed 
windoc.....> $A$5 

Bv..ild!> tk.e. J\ev.i 

me.'l~ -bar 

C.re.a re.~ J new 

w.ot" k.~heet 

STO'P 

·-·- ·-- --·-·. ----------~----·---·--··- _______ ..__ ----· 

,. 
j 

·--- ·------,-- --------··---+-~ ----



' 

I 

_, I L.3. 

I 
I 

M~nu. ~ Ddt~ 

ComMand : IM~.rt Data __ _ 

K~'-'tl N"dm<e.: TC\ser+ _clata ($F$1) 

.:;A,N(I!.!... 

~ 

~TAR.~ 

.a_nc.at"''"" e \se 
" 

Se.h ~la05 ~ut' l"oh:.h 
al) o\ ~l"'OOV'; d f" clWi• 

to FALSGlt.G-$ ?il, 

$G-$.~1) 

+ $F$11 

I 
C::&ar.s t~e c.>orlc:shee~ c.ee.a.- Screen 

I 
'f 

I 

I 

f'rOWJ p.-eviov..~ I ~A ~::S 
c.alc.tA} ~t ions 

f$12. 

y 

......... 

y 

______ _ _ .. -·--··· . . -·. __ ... ~:., aier:trd1iil!~- ··-··· 
box. • 

tJr;te.'\ dato- ill 

I y~ work:st.iee:c I - 1J:i1=$1~ 
'-· ---4~1---__..I ~F$Z17$F$2.!> 



J 

I.Jr• tes. data 
in, tha. wa .. lc. ~hee 

Wri ~es data in 

th.R.. work.~\.aeet 

Projeds dab"' 
H\C. t ir~t tile aro 
btA.ilds Fhe c.iorlcs 

Shol.Ns a/e ... t 
d ialo3 bc,x. 

~F$l.!Lt 

.. STO\' 

s~O(.\)~ a ler-t 
dia/od box. 



--~ 
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